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| 1. ORDERING GUIDE '

Configure a model number in this format: L20201DCV1, CBL01

|:|—| .....Digital panel meter with
screw terminal connectors.

I:H Dlsplay Color

DPM with green LED
2 .................. DPM with red LED
3 .... Extended DPM, green LED
Extended DPM, red LED

Note: Extended versions add
rate of change and lineariza-
tion of non-linear inputs. Not
available for thermocouple or
RTD inputs.

I:H Power

.......... 95-240Vac, 95-300 Vdc
1 ............. 10-48 Vdc, 10-34 Vac

I:H Setpomt Output

...................................... None
1 ............ Dual 8A contact relays
Dual solid state relays

I:H Analog Output

...................................... None
1 .................................... RS232
2 RS485
3 Parallel BCD
4 .., RS485-Modbus

I:H Input Type

DC Volts

DCV1 ..o, 200.00 mV
DCV2 ..., 2.0000 V
DCV3 ... 20.000 V
DCV4 ... 200.00 V
DCV5* ..., 600.0 V
DCV6 ....ccoovvveeeeeaaennn 300.0V

* Range not UL approved.

DC Amperes

DCA1 .................... 2.0000 mA
DCA2 .................... 20.000 mA
DCA3 ... 200.00 mA
DCA4 ... 5.000 A

P385C............... -202 to 850°C
P385F ............. -331 to 1562°F
P392C............. -202 to 850°C
P392F ............ -331 to 1562°F
Thermocouples

JC -210 to 760°C
JF o, -347 to 1400°F
KC ...ccvveee. -244 to 1372°C
KF...ovvee... -408 to 2501°F
TC..oooe, -257 to 400°C
TF o -430 to 752°F
EC...cooevveenne. -240 to 1000°C
EF .................. -400 to 1830°F
NC ... -245 to 1300°C
NF.....cccoe -410 to 2370°F
SC..oe, -46 to 1768°C
SF -51 to 3214°F
RC .....ccoeeei. -45 to 1768°C
RF....ccoveeenl. -49 to 3213°F

Process Signals
(4-20 mA, 0-10V, etc.)

P, 4-20 mA =0-100.00
P1............... Custom Scaling

Specify min signal & reading,
max signal & reading.

Strain Gauge, Potentiometer
(4-wire ratio)

SG ... 0-200 mV = 0-100.00
SG1 ... Custom Scaling
Specify min signal & reading,

max signal & reading. Full-
scale ranges 200 mV to 20V.

RMS Volts
RMV1................... 200.00 mV
RMV2...................... 2.0000 V
RMV3.................... 20.000 V
RMV4............. 200.00 V
RMV5* ....................... 600.0 V
RMVG......................... 300.0V
RMS Amperes
RMA1..................... 2.0000 mA
RMA2..................... 20.000 mA
RMA3..................... 200.00 mA
RMA4......................... 5.000 A

Load Cells (6-wire ratio)
WM1........ -99,999 to +99,999

Specify min input signal & dis-
played reading, and max input
signal & displayed reading.
Full-scale inputs 20 mV to 500
mV. 10 Vdc excitation.

Options

Extra bright red LED
display.

BL........ Blank lens, no
button pads.

Accessories

CBL01 .. RJ11-to-DB9 RS232
cable. Connects me-
ter to PC com port.

CBL02 .. USB-to-DB9 adapter.

For use with CBLO1.
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| 3. PRODUCT INTRODUCTION '

These UL-certified digital panel meters are versatile, cost effective solutions to a wide variety
of monitoring and control applications. Depending on the choice of signal conditioner, they are
easily set up for an accurate display of temperature, pressure, flow, weight, voltage or current,
all in appropriate engineering units and with zero and span adjustment when needed. Setup
can be via front panel pushbuttons or RS232/RS485. Selective security lockout of the front
panel keys protects against accidental changes to meter setup.

High read rates up to 60 per second (50 for 50 Hz operation) are made possible by Concurrent
Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power line cycle for
maximum noise rejection. High read rates provide accurate peak and valley capture, and quick
response for control applications. An adaptive digital filter supplies a time constant for the
encountered signal noise level, yet responds rapidly to changes that exceed a selected
threshold. Self-calibration occurs automatically after every 17th reading.

The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or 10-34 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output .

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is
via removable plugs conforming to UL61010C safety standards. All output options are isolated
from meter and power ground to 250 Vac.

Extended meter versions can linearize nonlinear inputs. Up to 240 data points may be
linearized by a computer program that stores setup parameters in nonvolatile memory.
Extended meters can also display rate of change. For example, they can display flow based on
changing tank level.

Alarm or setpoint control is made possible by two optional Form C mechanical relays (8A at
250 Vac) or two Form A solid state relays. The setpoints may be latching or non-latching, and
may be configured to be energized above or below the setpoint or in a fail-safe mode. The
relays can operate from the filtered signal to reduce relay chatter or from the unfiltered signal
for fastest response. Snubber circuits and a programmable relay switching time delay extend
relay contact life.

An isolated analog output of 4-20 mA or 0-10V is available with an optional analog output
board. The output is linearized to the display, and can operate from the filtered or unfiltered
signal input. It can be scaled via front panel pushbuttons or RS232/RS485.

Communications options available with Series 2 include RS232 or RS485 1/O, and parallel
BCD output. Serial communications can utilize a custom ASCII protocol or Modbus protocol
compliant with the Modbus Over Serial Line Specification V1.0 (2002) for 2-wire, half-duplex
connection. This includes RTU or ASCIlI modes, up to 247 digital addresses, and up to 32
devices per RS485 line without a repeater.

Computer-aided meter programming using special Setup Software is available for use with the
RS232 and RS485 serial interfaces.



l 4. RECEIVING & UPACKING I

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

AWarning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

e This unit must be powered with AC (mains) from 95-240 Vac +10% (90-300 Vdc) with the
high voltage power supply option, or 10-34 Vac +10% (10-48 Vdc) with the low voltage
power supply option. Verify that the proper power option is installed for the power to be
used. This meter has no AC (mains) switch. It will be in operation as soon as power is
connected.

e The 95-240 Vac (95-300 Vdc) mains connector (P1 Pins 1-3) is colored Green to
differentiate it from other input and output connectors. The 10-34 Vac (10-48 Vdc) mains
connector is colored Black.

e Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

e To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

e Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.

o Verify the panel cutout dimensions, and mount according to instructions.

Symbols used

A Caution (refer to accompanying documents) —L— Earth (ground) terminal.

A Caution, risk of electric shock. W Bothdirect and alternating current.

IE' Equipment protected throughout by double
insulation or reinforced insulation.

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



6. CONNECTOR WIRING INFORMATION

CONNECTORS

Connectors for signal and power are U/L
rated screw-clamp terminal blocks that
plug into mating jacks on the printed
circuit board. Communication connectors
are a single RJ11 plug for RS232, dual
RJ11 plugs for RS485, dual RJ45 plugs
for RS485 Modbus, and a 30-pin, mass
termination connector for parallel BCD.

P1 - POWER AND DIGITAL CONTROLS

ACHI (+DCHI)
AC NEUTRAL (DC RET)
EARTH GROUND

CONTROL INPUT 2 (+5V OUT)*
CONTROL INPUT 1*
DIGITAL GROUND

A85| |A85

Caution: Hazardous voltages may be present

on pins 4,5 & 6.

Note: Control inputs 1 & 2 are menu selectable.

P5 - SIGNAL INPUT
DC & PROCESS

Signal Source

-10V EXCITATION

+10 V EXCITATION

-EXCITATION 1
+EXCITATION 2
- SIGNAL INPUT 3
+S|IGNAL INPUT 4

in

in

out
+

2WIREPROCESS TRANSMITTER

=24V EXCITATION

Signal Source

.1
+24V EXCITATION 2
- SIGNAL INPUT 3

+

+SIGNAL INPUT 4

STRAINGAUGE
-1OVEXCITATION 1N

+10V EXCITATION 2 BELEH
SIGNAL 3 iR
+SIGNAL 4T

SIGNAL HIGH 1
NC 2E
SIGNALLOW 3

SIGNAL HIGH 4 Sis
INPUTS

AC NEUTRAL
.2, 2V, CURRENT

LOAD CELL METER
J5

-SENSE
-SIGNAL
+SIGNAL

DDA =W =

+SENSE

==l [=E[EE]

RTD (2-WIRE)

- EXCITATION 1

+ EXCITATION 2L,

- SIGNAL INPUT 3
+SIGNAL INPUT 4

m
0
Ll
'

RTD (3-Wl

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

RTD (4-WIRE)
- EXCITATION [iEn

+ EXCITATION 2

- SIGNAL INPUT 3 iETH
+SIGNAL INPUT 4 IR

- SIGNAL INPUT 3 jJiCE
+SIGNAL INPUT 4 5258




P2 - DUAL SETPOINT CONTROLLER

RELAY OUTPUTS (Rev J andearlier)

ALARM1-N/OCONTACT
ALARM 1-N/CCONTACT
ALARM1 - COMMON

ALARM?2 -N/OCONTACT
ALARM 2 -N/CCONTACT
ALARMZ2 - COMMON

(@) T &) B N B LN [

\EEE| [BEH|

SOLIDSTATERELAYOUTPUTS
(Rev J and earlier)

ALARM 1
ALARM 1
ALARM1

ALARM?2
ALARM?2
ALARM?2

Ok WOMN -

P3 - SERIAL COMMUNICATIONS

[ESE) EEH

+DC (AC)
+DC (AC)
~DC(NC)
+DC(AC)
+DC (AC)
-DC(NC)

RELAY OUTPUTS (RevKand later)

ALARM1-N/OCONTACT
ALARM1 - COMMON
ALARM 1 -N/CCONTACT

ALARM2-N/OCONTACT
ALARMZ2 - COMMON
ALARM 2- N/JCCONTACT

D W

|EEE| |EET

SOLIDSTATERELAYOUTPUTS
(Rev K and later)

ALARMA1
ALARM 1
ALARM 1

ALARM?2
ALARM?2
ALARM?2

DCCRAC
NOTUSED
DCORAC

DCORAC
NOTUSED
DCORAC



RS232 INTERFACE Computer
N/C
ISO GND GND
RX TX
TX RX
RTS RTS
N/C 1

RS485 INTERFACE - FULL DUPLEX
—GND

ND g
lgﬂﬁjs : L1 |BTX
ARX 4 . = oy ATX
3 mm | ARX °B™ 2
— ! _,'_' ARX 1SO| GND 1
s GND

ISO GND GND
TXDO
TXD1 ggg
RXD1

TXD1
RXDO TXDO

P4 - ANALOG OUTPUT

4 TO20 MAOUTPUT 11 I
0TO10VDC OUTPUT 2| mm
ISOLATED GROUND 3| [T

RS485 INTERFACE - HALF DUPLEX

ISO GND GND
ATX/ARX L‘ ATX / ARX
BTX/ BRX |J BTX / BRX
ISO GND 1 GND

RS485-MODBUS - HALF DUPLEX

ISO GND : GND
DO DO
D1 D1




| 7. MECHANICAL ASSEMBLY '

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

m ¥—__ Retaining tab

with tab release

Retaining tab —"

with tab release

Retaining tab ‘
~L L

Rear Panel

—h

— Retaining tab

REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-
tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may installed in the field. They will be recognized by the software, which will provide
access to the menu items associated with that board. If necessary, remove rear panel
knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Plug Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5




Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, then carefully align
the board connectors with the openings in the rear panel. If necessary, remove any rear
panel knockouts for new option boards that may have been installed. Ensure that all option
boards are properly aligned with the molded board retaining pins on the inside of the rear
panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal plugs.

PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

FRONTVIEW REARVIEW

[ 9Bmm ——p P2 P3 P5
{3.78in)
5mm
(O.197in)£ TOP VIEW SIDE VIEW
|
‘l o
| * Mounting Pawl
102mm
{4.02in) PANELCUTOUT

K

45 +0.6/-0.0mm
(1.772 +.024/-0.0in)

kg

EL FQL N i 92 +0.8-0.0mm ]
_______ , ] L (3.622 +.032/-0.0in)

Dimensioned case drawings
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l 8. FRONT PANEL SETUP KEYS I

:
ALARM 1 ALARM 2
STATUS STATUS
INDICATOR INDICATOR
MENU KEY ALARMKEY
(REVERSE MENU)
PEAK KEY RESET KEY
(DIGIT SELECT) (VALUE SELECT)

Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols (k= right arrow, » right
triangle, Al up triangle, «=ll |eft arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters as received from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. That jumper needs to
be removed for the Menu Mode to work, and menu items under Loc 1, Loc 2 and Loc 3 then
need to be set to "0" via the front panel for these menu items to be unlocked See Section 9.
The paragraphs below assume that all menu items have been unlocked.

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

E PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be
displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again will return the display to the present value. The PEAK key
can also be programmed to display Valley, to display alternating Peak or Valley, or to
Tare the reading to zero. When Peak or Valley is selected, periodic horizontals bars at
the top of the display indicate Peak, and periodic horizontals bars at the bottom indicate
Valley.

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
A RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter reset (same as power on). Meter reset can also be applied via a rear panel
connect or a serial ASCIl command.
11



ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
e again displays the setpoint for Alarm 2. Pressing it again returns to the present value.

KEYS IN MENU MODE

MENU

Y Right Arrow Key (MENU). Pressing l= steps the meter through all menu items that

have been enabled and then back to the Run Mode. With the DC signal conditioner

board and no option boards, available menu items are [JIIE 30 (FXEC, IEED
G SNEE, I Y, (YE:. [BX3E . If a change has been made to a menu

item, that change is saved to non-volatile memory when the I key is pressed next,
and RIS is displayed briefly.
E Right Triangle Key (Digit Select).

e Pressing P from the InPut menu brings up all meter functions available with the

meter's signal conditioner. For the DC signal conditioner, these are I,
and

e Pressing W from the SEtuP, ConfFG, FilLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:
00000R00000M00000R00000MO0000!

e Pressing P from the dEC.Pt menu item sequentially selects decimal point positions,

which il iash; .0 oc.c ofbco. fuod

asdll Up Triangle Key (Value Select). Pressing Al for a flashing item (digit position or
A decimal point position) will increment that item. Pressing MENU will save any changes.

e Left Arrow Key (Reverse Menu). Pressing 4=l has the same effect as the MENU key,
r =l €xcept that menu items are brought up in reverse order.

12



l 9. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of meter operation, any and all menu J1

items may be disabled or "locked out" so that they are no longer
directly accessible from the front panel. Each function to be disabled
is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and each function
to be enabled is set to "0." The top menu items Loc 1, Loc 2 and Loc
3 can in turn be locked out by installing an internal hardware jumper.
With the jumper installed, the operator only has access only to
enabled menu items. With the jumper removed, the operator also

has access to menu items Loc 1, Loc 2 and Loc 3.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section 9
and locate jumper “a” in the lower portion of the power supply board

next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS

When setting up the meter, it may be necessary to
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout
digit to "1" if you do not want the menu item to be
changed by an operator.

Loc 2
Press the l= MMENU key until Loc 1, Loc 2 or Loc 3
is displayed, as desired. Note: the hardware lockout
jumper must be removed (see above).

Press Pl to display the lockout status, consisting of
1’s and 0’s. The left digit will flash. Press P again to
step to the next digit, which will flash.

00000

12345

Press Alto set the flashing digit to "0" to enable the
menu item or to "1" to disable. Press MENU to enter.
See the table to the right for list of menu items that
can be enabled or disabled.

13
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Enabled or Disabled
Menu Items

Loc 1

1 - Input type selection.

2 - Meter setup, configuration
& decimal pt.

4 - Filter selection.

5 - Scale or Lo, Hi input.

6 - Offset or Lo, Hi reading

Loc 2

2 - Alarm setup.
3 - Alarm setpoint
value programming.
4 - Analog output scaling.
5 - Serial interface setup.

Loc 3

2 - View peak value
3 - View alarm setpoints

4 - Reset (peak & latched alarms)

5 - Reset (meter reset)




l 10. READING COORDINATES OF 2 POINTS SCALING METHOD I

When the reading coordinates of 2 points* scaling method has been selected under ,
the four menu items below will appear ahead of all other menu items when the MENU or
key is first pressed from the run mode.

This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a pressure transducer at zero pressure, and high signal, such as the
output of the same transducer at a known high pressure, are applied to the meter. The
desired corresponding low and high readings are then entered from the front panel. The
meter then applies straight line fit between the high and low calibration points. This scaling
method has the advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. This method is ideal for
process and load cell meters, which require zero and span adjustment. It is also available
for DC or AC meters. It is not available with thermocouple or RTD meters.

The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.

W Press Menu Select Press Digit Select 3] Press Value Select
H Key Key A Key

[®XIL Apply low signal input | JELFE]Press p to display | JElFXJPress Alto store low
(e.g., transducer output for 0 | reading at low signal input | reading.

psi). (e.g., 4.021 mA).
R Apply high signal input TIEYIPress Alto store high
(e.g., transducer output for | ZQUEE] Press B to display | reading.
known 100.00 psi source). | reading at high signal input

(e.g., 20.094 mA).
000.00[§000.00 000.0( X Select Zghru Jor
Mode to enter desired low OO EEN) Select digit | flashing first digit, Jthru Jfor
reading (e.g., 0.00). to flash. other flashing digits.

000.004000.00@ 000.0¢ Wi Select ahru lor
Mode to enter desired high OO RE) Select digit | flashing first digit, Jthru Jfor
reading (e.g., 100.00). to flash. a other flashing digits.

14



11. DC VOLTS, AMPS, PROCESS, STRAIN

The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (15), analog output (16), communication 1/O (17), parallel BCD output (18), and
transducer excitation output (19).

Voltage Ranges

FS Input E1 E2 E3

+200.00 mV
+2.0000 V
+20.000 V
+200.00 V
+300V (UL)
+600V (not UL)

www > >

QQ 3T — —

Current Ranges

FS Input E1 E2 E3
+2.0000 mA A e, g b
+20.000 mA A d, g b
+200.00 mA A ¢ g b
+5.000 A A | ab,g b

1. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
2. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
3. Store spare jumpers on an unused jumper post not associated a capital letter.

SCALE & OFFSET SETUP

For DC voltmeters & ammeters, a scale factor of 1 and an offset of 0 are used for direct
readings in (milli)volts or (milliJamperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 pA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.

For process & strain meters, scaling is normally set up from the front panel using the P and
Al keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Only menu items
applicable to the selected method will be presented. Please see the Glossary for an
explanation of items marked by an *.

15



KEYSTROKES FOR SETUP
If the MENU W= key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

il Press Menu Press Digit L3 Press Value Select
md Select Key Select Key Y ¥ Key
| 0.2UJl 2.0U §20.0U 2p0.0U 6R0.0U |
Selection of signal | DC Volts 0.2, 2, 20, 200, 660V FS
input type & range 2002020003 E
DC Amps 0.2, 20, 200 mA, 5A FS.

Strain gauge & ratio

0.2, 2,20V FS.

Meter Setup

[=]
O
O

0)
Dlsplay selection with
scale factor of 1.

] 4-1/2 digits (x20,000)

1] Remote display* (£99,999)

4-1/2 digits, counts by 10 (x20,000)
3-1/2 digits (x2,000)

WIN

tied to digital ground)
False = 0 (5V or open)

1= Peak or Valley Display, 2 = Tare*
1= Tare*, 2 = Reset*

00 _00 Noise minimized for 60 Hz

Power line frequency Noise minimized for 50 Hz

00_ 00 Scale and offset method*

Scaling method Coordinates of 2 points method*
Reading coordinates of 2 points method*

00_00 1= Reset*, 2 = Meter Hold*

Operation of control 1= Function Reset*, 2 = Peak*or Valley*

inputs 1 & 2: 1= Hold*, 2 = Peak or Valley Display

True = logic 1 (OV or 1= Hold*, 2 = Tare*

1=1,2 =1, decimal point = XXXXX
1=0, 2 =1, decimal point = XXXX.X
, decimal point = XXX.XX
, decimal point = XX.XXX

0
0
1, decimal point = XXXX.X
1
=0

1
0
1
0,
1
0
F

, decimal point = XXX.XX
, decimal point = XX.XXX
= 0, decimal point = X.XXX.X
unction Reset*, 2 = Display Blank*®
Hold*, 2 = Display Blank
s 1 = Peak or Valley, 2 = Display Blank*

1 = Tare*, 2 = Display Blank*

1 = Valley Display, 2 = Peak Display

1 = Tare*, 2 = Reset Tare to Zero

Nmmmmm

1
1
1
1
1=
A
1
1

Both inputs 1 and 2 set to 1 for selections
A L I, [® = Function Reset*
Both inputs 1 and 2 set to 1 for selections

0.0 8 E B E B [ = Meter Reset*
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N Press Menu Press Digit G534 Press Value Select
mmd Select Key Select Key Y Y Key
D00 _O| 1] Not rate of change
Meter Configuration | Operation as a rate of | (] Rate x 0.1
change meter*. ] Rate x 1
Extended meter* only. | § Rate x 10
M Rate x 100
J Rate x 1000
J Rate x 10000
1] Peak Display*. Also selects “Peak” in
Operation of front ~ “Peak or Valley” at connector above.
panel PEAK button d Valley Display*. Also selects “Valley” in
and rear connector for | “Peak or Valley” at connector above.
Peak or Valley Display | 4 Peak* (1st push), Valley* (2nd push)
q Front panel Tare*
D00 _ O 1] Meter comes up in normal run mode.
Auto-tare @l Meter comes up in auto-tare* mode
000 _ 0| ] Linear input
Nonlinear input scaling g Custom curve linearization

Extended meter* only.

FiLt

Filtering

00000 Unfiltered output

Alarm filtering Filtered output

00000 Unfiltered Peak* & Valley*
Peak & Valley filtering Filtered Peak* & Valley*

00000
Display filtering

Display batch average every 16 readings
Display filtered signal

[e)Jo] Adaptive filter
threshold

Low adaptive filter threshold level
High adaptive filter threshold level

Input signal filtering.
Can be applied to dis-
play, setpoint, analog
output, data output.

Autofilter*

Batch average, 16 readings
Moving average®, 0.08 sec.
Moving average®, 0.15 sec.
Moving average®, 0.3 sec.
Moving average®, 0.6 sec.
Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
Moving average®, 4.8 sec.
Moving average®, 9.6 sec.
S Unfiltered

[ 3> | P[P N]O[OA[WIIV[=[ORN= |OR= [OJ|— | O Q= [ O]

Dec. point selection

d.dddd
Decimal point flashes.

d.dddd
slefe[ele] Press Alto shift the decimal point.
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W=t} Press Menu Press Digit B33 Press Value Select

md Select Key Select Key Yy ¥ Key

Scaling method “Scale and Offset” if selected under 3015

SCALE OO JOIEN RN | Select E]thru Pfor flashing first digit, Jthru g

Scale factor® for other flashing digits. Select decimal point
0.00000.0000 0.000( g dg P
_ location when decimal point is flashing.
Select digit to flash.

. JOLN SN EELNL| Select E]thru Jfor flashing first digit, Jthru g

Offset value*® 0.0000M0.0000 for other flashing digits. Decimal point

Select digit to flash. location is selected by JeH;

Scaling method “Coordinates of 2 points” if se

lected under I3y

OO JLIEN RN | Select E]thru Pfor flashing first digit, Jthru
Low signal input. 0.0000M0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
Ol LTeLel MOl Select E]thru Pfor flashing first digit, Jthru g
Desired reading at | SHel0s] SNeLeLeN) for other flashing digits. Decimal point is set
Lo In. Select digit to flash. S EC.Pt
OGN OLTLl) HLRY | Select E]thru Pfor flashing first digit, Jthru g
High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
OO JOILN RN | Select E]thru Pfor flashing first digit, Jthru
Desired reading at | SolNN] SN for other flashing digits. Decimal point is set
Hi In. Select digit to flash S EC.Pt

Scaling method “Reading coordinates of 2 poi

nts” if selected under Uy

Low signal input.

Press &b store the low signal input in the
meter.

High signal input.

Press &b store the high signal input in the
meter.

0.0000 0.000(@0.0000
Desired reading at | SO Select E]thru for flashing first digit, Jthru
Lo In. Select digit to flash. for other flashing digits. Decimal point is set
by
00004167500
Desired reading at | JJee[il) Select E]thru for flashing first digit, Jthru
Hi In. Select digit to flash. for other flashing digits. Decimal point is set

)YAIEC.Pt




Option board dependent menu items

ALSEt]dEUTH[dEUZH[AEUTHAEUZ5

Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section15.

Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.

SEr1JSEr 2|SEr 3 JSEr 4|

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 17.

Menu lockout items

Loc 1

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*

See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [Jllal. Decimal point is set by X
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l 12. LOAD CELL & MICROVOLT INPUTS I

The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to 20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (15),
analog output (16), communication /O (17), parallel BCD output (18), and transducer
excitation output (19).

RANGE SELECTION VIA JUMPERS e \

Ranges & Display with
Scale Factor =1 /

Input Jumpers Full scale |
display !
+20 mV e +20000
+50 mV a +50000
+100 mV b +10000
+250 mV c +25000
+500 mV d +50000

Notes 1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP

For DC microvolt meters, a scale factor of 1 and an offset of 0 are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 pV. The decimal point is set
separately.

For load cell applications, scaling is normally set up from the front panel using the P and Al
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Please
see the Glossary for an explanation of each method. Please see the Glossary for an
explanation of each method marked by an *.
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KEYSTROKES FOR SETUP
If the MENU = key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

MENU

o

Press Menu
Select Key

Press Digit
Select Key

3l Press Value Select
Yy ¥ Key

Selection of signal
input type & range

Strain or ratiometric

20, 50, 100, 250, 500 mV FS voltage

True = logic 1 (OV or
tied to digital ground)

False = 0 (5V or open)

1= Hold*, 2 = Tare*
1= Peak or Valley Display, 2 = Tare*
1= Tare*, 2 = Reset*

1250.0 §  500.
DC millivolts 20, 50, 100, 250, 500 mV FS voltage
00_00 | 4-1/2 digit meter, counts by 1
Meter Setup Display type gl 5-digit remote display* (£99,999)
¥i 4-1/2 digit meter, counts by 10
¥ 3-1/2 digit meter
00 _00 Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00_ 00 Scale and offset method*
Scaling method Coordinates of 2 points method*
Reading coordinates of 2 points method*
00_00 1= Reset*, 2 = Meter Hold*
Operation of control 1= Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2: 1= Hold*, 2 = Peak or Valley Display

1=1, 2 =1, decimal point = XXXXX
1=0, 2 =1, decimal point = XXXX.X
, 2 =0, decimal point = XXX.XX
0, decimal point = XX.XXX
1, decimal point = XXXX.X
= 1, decimal point = XXX.XX
= 0, decimal point = XX.XXX
, 2 =0, decimal point = X.XXX.X
Function Reset*, 2 = Display Blank*®
1= Hold*, 2 = Display Blank
s 1 = Peak or Valley, 2 = Display Blank*
= Tare*, 2 = Display Blank*
Valley Display, 2 = Peak Display
Tare*, 2 = Reset Tare to Zero

2
2
2
2

O -0 20 -

1
1
1

Both inputs 1 and 2 set to 1 for selections
P, 2, I, [€ = Function Reset*
Both inputs 1 and 2 set to 1 for selections

0.0 E E B E B B = Meter Reset*
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N Press Menu Press Digit G534 Press Value Select
mmd Select Key Select Key Y Y Key
000_0 1] Not rate of change
Meter Configuration | Operation as a rate of | (] Rate x 0.1
change meter*. ] Rate x 1
Extended meter* only. | § Rate x 10
M Rate x 100
J Rate x 1000
J Rate x 10000
D 1] Peak Display*. Also selects “Peak” in
Operation of front ~ “Peak or Valley” at connector above.
panel PEAK button d Valley Display*. Also selects “Valley” in
and rear connector for | “Peak or Valley” at connector above.
Peak or Valley Display | 4 Peak* (1st push), Valley* (2nd push)
q Front panel Tare*
D00 O 1] Meter comes up in normal run mode.
Auto-tare @l Meter comes up in auto-tare* mode
D ] Linear input
Nonlinear input scaling g Custom curve linearization

Extended meter* only.

FiLt
Filtering

00000
Alarm filtering

Unfiltered output
Filtered output

00000
Peak & Valley filtering

Unfiltered Peak* & Valley*
Filtered Peak* & Valley*

00000

Display filtering

Display batch average every 16 readings
Display filtered signal

[e)Jo] Adaptive filter
threshold

Low adaptive filter threshold level
High adaptive filter threshold level

Input signal filtering.
Can be applied to dis-
play, setpoint, analog
output, data output.

Autofilter*

Batch average, 16 readings
Moving average®, 0.08 sec.
Moving average®, 0.15 sec.
Moving average®, 0.3 sec.
Moving average®, 0.6 sec.
Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
Moving average®, 4.8 sec.
Moving average®, 9.6 sec.
S Unfiltered

[ 3> | P[P N]O[OA[WIIV[=[ORN= |OR= [OJ|— | O Q= [ O]

Dec. point selection

d.dddd
Decimal point flashes.
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W=t} Press Menu Press Digit B33 Press Value Select

md Select Key Select Key Yy ¥ Key

Scaling method “Scale and Offset” if selected under 3015

SCALE OO JOIEN RN | Select E]thru Pfor flashing first digit, Jthru g

Scale factor® for other flashing digits. Select decimal point
0.00000.0000 0.000( g dg P
_ location when decimal point is flashing.
Select digit to flash.

. UL JLIEN EELRL | Select E]thru Pfor flashing first digit, Jthru g

Offset value* 0.0000M0.0000 for other flashing digits. Decimal point

Select digit to flash. location is selected by JeH;

Scaling method “Coordinates of 2 points” if se

lected under I3y

OO JLIEN RN | Select E]thru Pfor flashing first digit, Jthru
Low signal input. 0.0000M0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
Ol LTeLel MOl Select E]thru Pfor flashing first digit, Jthru g
Desired reading at | SHel0s] SNeLeLeN) for other flashing digits. Decimal point is set
Lo In. Select digit to flash. S EC.Pt
OGN OLTLl) HLRY | Select E]thru Pfor flashing first digit, Jthru g
High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
OO JOILN RN | Select E]thru Pfor flashing first digit, Jthru
Desired reading at | SolNN] SN for other flashing digits. Decimal point is set
Hi In. Select digit to flash S EC.Pt

Scaling method “Reading coordinates of 2 poi

nts” if selected under Uy

Low signal input.

Press &b store the low signal input in the
meter.

High signal input.

Press &b store the high signal input in the
meter.

0.0000 0.000(@0.0000
Desired reading at | SO Select E]thru for flashing first digit, Jthru
Lo In. Select digit to flash. for other flashing digits. Decimal point is set
by
00004167500
Desired reading at | JJee[il) Select E]thru for flashing first digit, Jthru
Hi In. Select digit to flash. for other flashing digits. Decimal point is set

)YAIEC.Pt
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Option board dependent menu items

ALSEt]dEUTH[dEUZH[AEUTHAEUZ5

Menu items related to alarm setup These iwill only appear if a relay board is detected. If
so, please see Section15.

Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.

SEr1JSEr 2|SEr 3 JSEr 4|

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 17.

Menu lockout items

Loc 1

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.
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| 13. AC RMS VOLTS & AMPS |

The AC RMS Voltmeters and Ammeters utilize an AC signal conditioner board with precision
circuitry to compute the root-mean-square of complex waveforms from 10 Hz to 10 kHz.
Spikes up to 2.4 times the maximum of each range are accurately measured. The input is AC
coupled to read only the AC component, such as ripple on a power supply. The board needs to
be configured via jumpers for the desired voltage or current range. All signal ranges are factory
calibrated with calibration factors stored in EEPROM. The meter software recognizes the
board and will bring up the appropriate menu items for it; however, it does not recognize the
jumper settings which set the ranges. These need to be entered manually. Please see further
manual sections for setup of the following features: relay output (15), analog output (16),
communication 1/O (17), parallel BCD output (18), and transducer excitation output (19).

Voltage Ranges

Full Scale Input | Counts | Jumpers 1 re;l | H—II
200 mV 20000 | g, k - 3 il
2V 20000 | g, j LIe[ 1] — Ca D
20V 20000 | h,k RN
200V 20000 h, | - =l ¥

300V (UL) 3000 fi m EcH

600V (not UL) 6000 f] [ —— P

Current Ranges

CE

Full Scale Input | Counts | Jumpers

2 mA 20000 e f k

20 mA 20000 d, f, k RANGE SELECTION VIA JUMPERS

200 mA 20000 c, f, k 1. Use 2.5 mm (0.1") jumpers.

5A 5000 a, b, f,m 2. Store spare jumpers on unused jumper post.

METER SCALING

Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
can be set for direct readout in (milli)volts or (milli)Jamperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.

The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.

All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters. Readings below 10 counts are displayed as 0.
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KEYSTROKES FOR SETUP
If the MENU W= key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

=l Press Menu Press Digit GH3) Press Value Select
md Select Key Select Key Y 9 Key
' | 0.2UJ 2.0U H20.0U 3p0.0U 6§0.0U |
Selection of signal | Strain or ratiometric 0.2, 2, 20, 200, 660V FS
input type & range ™ 2.0aj] 20.0a §200.0a §p.0a |
DC millivolts 0.2, 20, 200 mA, 5A FS.
00_00 W 4-1/2 digits (£20,000)

Meter Setup

Display selection with
scale factor of 1

gl Remote display* (£99,999)
¥i 4-1/2 digits, counts by 10 (x20,000)
¥ 3-1/2 digits (x2,000)

0
Power line frequency

Noise minimized for 60 Hz
Noise minimized for 50 Hz

0
Scaling method

Coordinates of 2 points method*

Scale and offset method*
Reading coordinates of 2 points method*

00_00

Operation of control
inputs 1 & 2.

True = logic 1 (OV or
tied to digital ground)
False =0 (5V or open)

Reset*, 2 = Meter Hold*

Function Reset*, 2 = Peak*or Valley*
Hold*, 2 = Peak or Valley Display
Hold*, 2 = Tare*

Peak or Valley Display, 2 = Tare*
Tare*, 2 = Reset”

, 2 =1, decimal point = XXXXX

1, decimal point = XXXX.X

0, decimal point = XXX.XX

0, decimal point = XX.XXX
1,
1,

1
1

—_— )

0
0
1,
0,
0
F

=1
—_—
I

decimal point = XXXX.X
decimal point = XXX.XX

2
2
2
2
2
2

0, decimal point = XX.XXX

—_—

1,

, 2 =0, decimal point = X.XXX.X
unction Reset*, 2 = Display Blank*®
Hold*, 2 = Display Blank
Peak or Valley, 2 = Display Blank*®
Tare*, 2 = Display Blank*

Valley Display, 2 = Peak Display
Tare*, 2 = Reset Tare to Zero

olOlml >l
[ N S O

Both inputs 1 and 2 set to 1 for selections
A, B B, [€ = Function Reset*
Both inputs 1 and 2 set to 1 for selections

0.0 E E B E B B = Meter Reset*
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Extended meter* only.

N Press Menu Press Digit G534 Press Value Select
mmd Select Key Select Key A LG
0 1] Not rate of change
Meter Configuration | Operation as a rate of | (] Rate x 0.1
change meter*. 7 Rate x 1
Extended meter* only. | § Rate x 10
1 Rate x 100
J Rate x 1000
J Rate x 10000
D 1] Peak Display*. Also selects “Peak” in
Operation of front ~ “Peak or Valley” at connector above.
panel PEAK button d Valley Display*. Also selects “Valley” in
and rear connector for | “Peak or Valley” at connector above.
Peak or Valley Display | 4 Peak* (1st push), Valley* (2nd push)
g Front panel Tare*
000 _0 1] Meter comes up in normal run mode.
Auto-tare d Meter comes up in auto-tare* mode
0 1] Linear input
Nonlinear input scaling | I Custom curve linearization

FiLt

Filtering

00000
Alarm filtering

Unfiltered output
Filtered output

00000
Peak & Valley filtering

Unfiltered Peak* & Valley*
Filtered Peak* & Valley*

00000
Display filtering

Display batch average every readings
Display filtered signal

Yele)rlo) Adaptive filter
threshold

Low adaptive filter threshold level
High adaptive filter threshold level

Input signal filtering.
Can be applied to dis-
play, setpoint, analog
output, data output.

Autofilter*
Batch average, 16 readings
Moving average®, 0.08 sec.
Moving average®, 0.15 sec.
Moving average®, 0.3 sec.
Moving average®, 0.6 sec.
Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
Moving average®, 4.8 sec.
Moving average®, 9.6 sec.
Unfiltered

[P [P NIOCIRIW]NV=ORI= ORI — | ORj|— | ORI —=] O]

Dec. point selection

d.dddd
Decimal point flashes.

ddddd
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W=t} Press Menu Press Digit 333 Press Value Select

md Select Key Select Key Yy ¥ Key

Scaling method “Scale and Offset” if selected under 3y

SCALE OO JOIEN RN | Select E]thru Pfor flashing first digit, Jthru g

Scale factor® for other flashing digits. Select decimal point
0.00000.0000 0.000( g dg P
_ location when decimal point is flashing.
Select digit to flash.

. UL JLIEN EELRL | Select E]thru Pfor flashing first digit, Jthru g

Offset value* 0.0000M0.0000 for other flashing digits. Decimal point

Select digit to flash. location is selected by JeH;

Scaling method “Coordinates of 2 points” if se

lected under I3y

OO JLIEN RN | Select E]thru Pfor flashing first digit, Jthru
Low signal input. 0.0000M0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
Ol LTeLel MOl Select E]thru Pfor flashing first digit, Jthru g
Desired reading at | SHel0s] SNeLeLeN) for other flashing digits. Decimal point is set
Lo In. Select digit to flash. S EC.Pt
OGN OLTLl) HLRY | Select E]thru Pfor flashing first digit, Jthru g
High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.
OO JOILN RN | Select E]thru Pfor flashing first digit, Jthru
Desired reading at | SolNN] SN for other flashing digits. Decimal point is set
Hi In. Select digit to flash S EC.Pt

Scaling method “Reading coordinates of 2 poi

nts” if selected under 3y

Low signal input.

Press &b store the low signal input in the
meter.

High signal input.

Press &b store the high signal input in the
meter.

0.0000 0.000(@0.0000
Desired reading at | SO Select E]thru for flashing first digit, Jthru
Lo In. Select digit to flash. for other flashing digits. Decimal point is set
by
00004167500
Desired reading at | JJee[il) Select E]thru for flashing first digit, Jthru
Hi In. Select digit to flash. for other flashing digits. Decimal point is set

)YAIEC.Pt
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Option board dependent menu items

ALSEt]dEUTH[dEUZH[AEUTHAEUZ5

Menu items related to alarm setup These iwill only appear if a relay board is detected. If
so, please see Section15.

Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.

SEr1JSEr 2|SEr 3 JSEr 4|

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 17.

Menu lockout items

Loc 1

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*

See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [Jllal. Decimal point is set by X
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l 14. TEMPERATURE: THERMOCOUPLE & RTD I

Thermocouple and RTD meters utilize the temperature signal conditioner board, which can be
configured via jumpers for 7 thermocouple types (J, K, T, E, N, S, R) and 2 Pt 100 RTD types
(DIN with temperature coefficient of 0.00385 ohms/ohm/°C or ANSI with temperature coeffi-
cient of 0.003925 ohms/ohm/°C). All signal ranges are factory calibrated. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Display in °C or °F and resolution of 1°, 0.1° or 0.01° are user
programmable. High resolution should only be used for relative readings, not absolute
readings. Although available, 0.01° resolution is not recommended for thermocouples.

The addition of a relay output board turns the meter from a temperature indicator into a
temperature controller. Please see further manual sections for setup of the following features:
relay output (Section 15), analog output (16), communication 1/O (17), parallel BCD output
(18), and transducer excitation output (19).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

J,K, E, N

e

Pt 100 RTD connection

Connection

Jumpers

2- or 4-wire

b, e

Thermocouples R \
Type Jumpers / a \
\

T,R,S f /
7
Open Indication Jumpers \ . /
Upscale c e
Downscale d e

3-wire a, e £ D .- \ 1

1. Use 2.5 mm (0.1") jumpers. e
2. Store spare jumpers on an unused jumper post.

SCALE & OFFSET SETUP

Scale is available for RTDs (but not thermocouples) and is normally set to 1.0000. Scale can
be used as an adjustment when actual resistance is other than 100 ohms, as stated on the
RTD calibration sheet. To calculate scale, divide 100 by the stated resistance at 0°C. For
example, for a 99.04 ohm RTD, scale should be set to 100 / 99.04 = 1.0097.

Offset is available for thermocouples and RTDs, and is normally set to 0000.0. If °C is
selected, entering an offset of 0273.2 will change the display to Kelvin. If °F is selected,
entering 0459.7 will change the display to Rankine.
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RTD CONNECTION

With the appropriate a, b, e jumper positions,

-Excitation | 1 —
the RTD meter allows 2, 3 or 4-wire RTD +E§Ei’taiinn 5 __‘
hookup to the J5 connector, as illustrated. _Signal input | 3 |:|
The meter applies an excitation current of 0.2 +Signal input | 4 !

mA, which it monitors to make ratiometric
corrections for excitation supply variations.

In 2-wire hookup, the meter senses the
voltage drop across the 100 ohm RTD and

2.wire Pt100 RTD

J-wire Pt100 RTD

both lead wires. The effect of the lead wires -Excitation | 1 —
can be measured and subtracted by shorting +Excitation | 2 1 |:|
out the RTD during meter setup. The short -g!gna: !“Fﬁ 3 I
should be as close as possible to the RTD. Felgnat np

Ambient temperature changes will still cause

some error in the readings -- the higher the

lead resistance, the greater the error. 4 wire Pt100 RTD
2-wire lead resistance compensation -Excitation | 1 ——
Under the menu selection, the two ;:igf?j'&; ; | |
RTD leads are shorted out, the P key is +Signal input | 4

pushed, a value proportional to lead resist-
ance is displayed, and that value is auto-

matically stored in the meter. After this step, DIN or ANSI and °F or °C need to be selected.

In 3-wire hookup, the meter automatically compensates for lead resistance by measuring the
voltage drop in one current carrying lead and assuming that the other current carrying lead is
the same.

In 4-wire hookup, no compensation for lead resistance is necessary. The step of shorting out
the RTD during meter setup is not necessary with either 3 or 4-wire hookup.
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KEYSTROKES FOR SETUP
If the MENU = key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

i Press Menu Press Digit 33 Press Value Select
md Select Key Select Key y ¥ Key
| InPut Ml TypedJ,°For°C

Selection of signal
input type & range

Thermocouple

P
o
(@)

Type K, °F or °C
Type N, °F or °C
Type E, °F or °C
Type T, °F or °C
Type S, °F or °C
Type R, °F or °C

mils
Slo

(4]
o
(@]

r°cC

Pt 100 ohm RTD

(.

o

-n
-~
o
o

'
Q.

o
(@]

4-wire DIN , °F or °C
4-wire ANSI, °F or °C
3-wire DIN, °F or °C
3-wire ANSI, °F or °C
2-wire DIN, °F or °C
2-wire ANSI, °F or °C
EILid 2-wire lead resistance compensa-
tion. After selecting Short, press I to reset
the meter, short the two leads adjacent to
the RTD, and press P to automatically store
a value proportional to lead resistance. After
that, go back to select

wlwls
>|al>
o

sl
Njw|lwld
ol
o
olalolo

N
>

o
-
N
>

o
(9]

Meter Setup

00 00
Display selection with
scale factor of 1.

0.1 degree resolution
Remote display* (+99,999)
0.01 degree resolution

1 degree resolution

WINI=[O

00 00 Noise minimized for 60 Hz
Power line frequency % Noise minimized for 50 Hz
00_ 00 [ Scale and offset method* for RTDs,
Scaling method offset only for thermocouples
00_00 / 1 = Reset*, 2 = Meter Hold*
Operation of control gl 1 = Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2: r411 = Hold*, 2 = Peak or Valley Display
True = logic 1 (OV or 8 1 =Hold*, 2 =Tare*
tied to digital ground) L 1 =Peak or Valley Display, 2 = Tare*

& 1 = Tare*, 2 = Reset”

False = 0 (5V or open)

32




MENU

b=

Press Menu
Select Key

Press Digit
Select Key

= Press Value Select
¥y ¥ Key

Meter Setup
(continued)

Operation of control
inputs 1 & 2:

(continued)

J1 =1, 2 =1, decimal point = XXXXX
B , 2 =1, decimal point = XXXX.X
= 0, decimal point = XXX.XX
, decimal point = XX.XXX

, decimal point = XXXX.X
, decimal point = XXX.XX
, decimal point = XX.XXX
= 0, decimal point = X.XXX.X
unction Reset*, 2 = Display Blank*®
old*, 2 = Display Blank

eak or Valley, 2 = Display Blank*®
are*, 2 = Display Blank*

alley Display, 2 = Peak Display
are*, 2 = Reset Tare to Zero

1
- O

NNMDNDDNDDNDDN

TTO_,0 =0

0
1
1
0

<7

1
1
1
1
1
1
1
g1
1
1
1
1
1

—

Both inputs 1 and 2 set to 1 for selections
q 4 N 8= Function Reset*
Both inputs 1 and 2 set to 1 for selections

133333 3 3= Meter Reset*

Meter Configuration

U

Operation as a rate of
change meter*.
Extended meter* only.

Not rate of change
Rate x 0.1

Rate x 1

Rate x 10

Rate x 100

Rate x 1000

Rate x 10000

Operation of front
panel PEAK button
and rear connector for
Peak or Valley Display

Peak Display*. Also selects “Peak” in

“Peak or Valley” at connector above.

l Valley Display*. Also selects “Valley” in
“Peak or Valley” at connector above.

g Peak* (1st push), Valley* (2nd push)

¢ Front panel Tare*

FiLt

Filtering

00000 1] Unfiltered output

Alarm filtering Filtered output

00000 1] Unfiltered Peak™ & Valley*

Peak & Valley filtering Filtered Peak* & Valley*

00000 Display batch average every 16 readings

Display filtering

1— 1O

Display filtered signal

qealife] Adaptive filter
threshold

Low adaptive filter threshold level
High adaptive filter threshold level

1= O]
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Wl Press Menu Press Digit =3 Press Value Select

md Select Key Select Key Yy ¥ Key

FiLt 00000 Autofilter*

Filtering Input signal filtering. Batch average, 16 readings
(continued) Can be applied to dis- Moving average*, 0.08 sec.

play, setpoint, analog
output, data output.

Moving average*, 0.15 sec.
Moving average*, 0.3 sec.

Moving average*, 0.6 sec.

Moving average*, 1.2 sec.

Moving average*, 2.4 sec.

Moving average®, 4.8 sec.

Moving average®, 9.6 sec.
Unfiltered

EC.P d-ddd
d

Dec. point selection | Decimal point flashes. | [FERE

[=)

SCALE LI [EILL CHLRE |Select gkhru Jor flashing first digit, Jhru J
Scale factor* 0.00008 0.000d0.0000 for other flashing digits. Select decimal point
e n location when decimal point is flashing.

Select digit to flash.
OFF st CRL0 LNl CELDLY (Select khru Jor flashing first digit, Jkhru J
Offset value*® 0.0000W 0.000( for other flashing digits. Use offset for display
Select digit to flash. in Rankine or Kelvin. Decimal point location

is selected by [s|efy4:.

Option board dependent menu items

ALSE]dEUTH[dEUZH[GEUTBAEUZb

Menu items related to alarm setup These will only appear if a relay board is detected. If
so, please see Section15.

Menu items related to analog output setup. These will only appear if an analog
output board is detected. If so, see Section 16.

SEr 1]SEr 2|SEr 3 SEr 4|

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/0 board is detected. If so, see Section 17.

Menu lockout items

Loc 1

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.
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l 15. DUAL RELAY OUTPUT OPTION I

An optional dual contact relay board or dual solid state relay board may be may be installed in
the meter main board at plug position P12, adjacent to the power supply board. Once installed,
the relay board is recognized by the software, which will bring up the appropriate menu items.
These menu items will not be brought up if a relay board is not installed. Both relay boards
offer a choice of operating modes: latched* or non-latched*, hysteresis band*, deviation band*,
actuation based on the filtered or unfiltered signal, and selectable number of readings in alarm
zone to cause an alarm. Please see the Glossary at the end of this manual for an explanation
of terms marked by an *.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

It is not necessary to enter the setup menu to view or change setpoints. This allows the meter
to continue conversions and provide outputs when setpoints are displayed. After pressing ‘=l
(Alarms), you have 30 seconds to enter a change, or the meter reverts to normal display.

e Press Alarms Press Digit L) Press Value Select
e Key Select Key Yy Y Key
300.24 200.00 295.00
Press 4l (Alarms) to Current setpoint 1 value blinks, | To change setpoint 1 value,
display Alarm 1 setpoint. | and Alarm 1 LED indicator press Alto change selected
lights. Press Po select a digit, blinking digits.
which will blink.
395.00 395.00 305.00
Press 4=l (Alarms) to Current setpoint 2 value blinks, | To change setpoint 2 value,
display Alarm 2 setpoint. | and Alarm 2 LED indicator press Alto change selected
lights. Press Pio select a digit, blinking digits.
which will blink.
K[IFPY Press 4wl (Alarms) again. The meter will reset and display the current reading.

KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

M Press Menu Press Digit 331 Press Value Select

md Select Key Select Key F ¥ Key

[[ Relay 1 on Relay 2 on
Alarm Setup. Relay state when E Relay 1 off Relay 2 on
Press lmap| until alarm is active. E Relay 1 on Relay 2 off
ALSEt is displayed E Relay 1 off Relay 2 off

(with relay board). -
00000

Alarm latching* or non-
latching® (auto reset).

Alarm 1 auto reset Alarm 2 auto reset
Alarm 1 latching Alarm 2 auto reset
Alarm 1 auto reset Alarm 2 latching
Alarm 1 latching Alarm 2 latching

(PR NP
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= Press Menu Press Digit 3] Press Value Select
mmd Select Key Select Key Yy 9 Key
1] AL1 active high AL2 active high
Alarm Setup. Alarm operates atand | (] AL1 active low AL2 active high
(continued) above setpoint (active | 4 AL1 disabled AL2 active high
high) or at and below g AL1 active high AL2 active low
setpoint (active low). 1 AL1 active low AL2 active low
J AL1 disabled AL2 active low
J AL1 active high AL2 disabled
@ AL1 active low AL2 disabled
J AL1 disabled AL2 disabled
] AL1 band deviation AL2 band deviation
Hysteresis mode* or d AL1 hysteresis AL2 band deviation
band deviation mode* | 4 AL1 band deviation AL2 hysteresis
g AL1 hysteresis AL2 hysteresis
1 No deviation or hysteresis in menu.
1] After 1 reading
Number of readings in | {I After 2 readings
alarm zone to cause 7 After 4 readings
an alarm. q After 8 readings
] After 16 readings
J After 32 readings
J After 64 readings
d After 128 readings
Select E]thru Yfor flashing first digit, Jthru J
Alarm 1 hysteresis* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of hysteresis band).
Select E]thru Yfor flashing first digit, Jthru I
Alarm 2 hysteresis* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of hysteresis band).
b Select E]thru Jfor flashing first digit, Jthru J
Alarm 1 deviation* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of deviation band).
b Select g]thru Jfor flashing first digit, Jthru 2
Alarm 2 deviation* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value

entered (half of deviation band).

* See Glossary for explanation of item.

36




l 16. ANALOG OUTPUT OPTION I

An optional analog board may be may be connected to the meter main board at plug position
P14, adjacent to the signal conditioner board. Once installed, the analog output board is
recognized by the meter, which will bring up the appropriate menu items. These items will not
be brought up if an analog output board is not installed.

Both current (0-20 mA or 4-20 mA) and voltage (0-10 Vdc) | ;1590 mMa outPUT '
analog outputs are selectable at connector P4. One of three | o710 10 vDC OUTPUT 2
analog output spans (0-20 mA, 4-20 mA or 0-10 Vdc) may be ISOLATED GROUND 3
selected in software for scaling. The low analog output (0 mA,
4 mA or 0V) may be set to correspond to any low displayed
reading An Lo. The corresponding high analog output (20 mA
or 10V) may be set to correspond to any high displayed reading An Hi. The meter will then
apply a straight line fit between these two end points, thereby providing an analog output
scaled to the displayed reading for the selected span.

mjul=

P4 - ANALOG OUTPUT

Although both current and voltage outputs are available at connector P4, only one is calibrated
to specifications. If the calibrated output is 0-10V, the non-calibrated output is 0-20 mA. If the
calibrated output is 0-20 mA, the non-calibrated output is 0-10V. Both of these non-calibrated
outputs are accurate to 1% typical, 2% max. If the calibrated output is 4-20 mA, the non-
calibrated output is 2.5-10V.

KEYSTROKES FOR SETUP
If the MENU = key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

M Press Menu Press Digit Select 331 Press Value Select
md Select Key Key ¥ Y Key
00 | 1] 0-20 mA current output
Analog Output Setup. | Selection of calibrated output. | J 0-10V voltage output
Press s until AnSEt 7 4-20 mA current output
:nillzgiﬁetgu([eb%l:;s)s D0__| 1] Analog output unfiltered

"~ | Analog output filtering. g Analog output filtered
0.0000[§0.0000§0.0000 Select E]thru for flashing first
Low displayed value 0.000000.0000 digit, Jthru gfor other flashing
forOmA, 4 mAor0V | gelect digit to flash. digits. Decimal point location is
output fixed by o/elgiselection.
0.0000[§0.0000§0.0000 Select E]thru Jfor flashing first
High displayed value | TEee[is] SeleJo]1 digit, Jthru gfor other flashing
for 20 mA or 10V out- | gelect digit to flash. digits. Decimal point location is
put fixed by s|efigiselection.
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l 17. SERIAL COMMUNICATION OPTIONS I

An optional serial communications board (RS232, RS485 or RS485-Modbus) may be con-
nected to the meter main board at plug position P13 (middle position). Once installed, this
board is recognized by the meter, which will bring up the appropriate serial communication
menu items. These items will not be brought up if a communication board is not installed.

The RS485 and RS485-Modbus boards are electrically equivalent, but have a slightly different
physical layout. The RS485 version uses two RJ11 connectors, while the RS485-Modbus
version uses two RJ45 connectors for compliance with the Modbus standard. Both boards
feature dual connectors, which are wired in parallel to allow daisy chaining of addressable
meters with no need for a communications hub. All three boards are compatible with the same
serial three communication protocols, which are selectable under meter setup: Custom ASCII*,
Modbus* RTU, and Modbus* ASCII. Digital addressing of multiple meters on the same serial
communication line requires RS485 or RS485-Modbus boards.

BOARD SETUP VIA JUMPERS

RS232 Board

g - Normal operation. ;
h - Slave display operation to RS232 output =
of another meter. L1
J - Pull-up resistor on RTS line. j
Note: The board is shipped standard with jumpers R3-232 .
g and j installed.
RS485 and RS485-Modbus Boards .
Full Duplex Operation mbhnm EcEdm
b & e - These bias jumpers should be installed on mem ufm
1 (and only 1) meter.
a & d - installed on last meter in line with long RS-4835
cable runs.
Half Duplex Operation
L _ mdmce =
b & e - bias jumpers installed on 1 board. @
c & f - installed for half duplex operation. n ufm
a - installed on last meter in line with long cable runs. mam mbnm
Note: The boards are shipped standard with no Modbus

jumpers installed.
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KEYSTROKES FOR SETUP
If the MENU = key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

-
ﬁ
()
(=
(=)

Termination characters

Only at end of all items
At end of each item

= Press Menu Press Digit Select 333l Press Value Select
md Select Key Key Y ¥ Key
1] Send unfiltered signal
Fixed Parameters: | Output filtering d Send filtered signal
N i —
0 parity ] 300 baud
8 data bits
1 stop bit Baud rate d 600 baud
J 1200 baud
g 2400 baud
7 4800 baud
g 9600 baud
J 19200 baud
60 Hz 50 Hz
Output update rate 1] Line frequency Line frequency
d 0.28 sec 0.34 sec
74 0.57 sec 0.68 sec
g 1.1sec 1.4 sec
] 2.3sec 2.7 sec
J 4.5sec 5.4 sec
g 9.1sec 10.9 sec
d 18.1sec 21.8 sec
J 36.6 sec 43.5 sec
J 72.5sec 97 sec
0000 1] No line feed after carriage return
Serial Setup 2 Line feed g Line feed after carriage return
0000 ] No alarm data
Alarm data with readings g Alarm data with reading
0000 1] Continuous data output
Control of data output g Data output on ASCIl command only
0000 Select Uthru gifor addresses 1 thru 15.
Meter address with Custom | Select tMthru g (with decimal point) for
ASCII protocol* addresses 16 thru 31.
00000 ] Full duplex
Serial Setup 3 Half or full duplex d Half duplex
00000 1] Standard continuous mode
Special start & stop char. fl Special start & stop characters
00000 1] Normal RTS
RTS mode fl Single transmission
D |
d
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= Press Menu Press Digit Select 333 Press Value Select
mmd Select Key Key Y ¥ Key
D0000 ] Reading
Serial Setup 3 Data sent in continuous d Peak
(continued) mode q Valley
g Reading + peak
7] Reading + valley
d Reading + peak + valley
1] 1sec
Serial Setup 4 Modbus* ASCII gap timeout | ] 3 sec
4 5sec
q 10sec
] Custom ASCII*
Serial protocol d Modbus* RTU
4 Modbus* ASCII
1] None
Parity d Odd
4 Even
158
Modbus Address Select digit to flash. Select Jthrough Jfor flashing digit.

Address range is 1 to 247.

* See Glossary for explanation of item.
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l 18. PARALLEL BCD OUTPUT OPTION I

An optional parallel BCD output board may be connected to the meter main board at plug
position P13 (middle position). Once installed, the board is recognized by the meter, which
will bring up the appropriate menu items. The BCD board provides isolated, buffered,
stored, 3-state parallel outputs that are jumper selectable for either 0-5V logic (LSTTL,
CMOS compatible) or 0-15V dc. BCD outputs are positive true. Polarity bit is positive true

for +sign.
Logic Level Jumper
0 to 5 Vdc b
0 to 15Vdc a

BCD CONTROL SIGNALS

Enable

/ BCD Hold Logic 0 - BCD from last update prior to
BCD Hold going low is stored.
Logic 1 - BCD information is

Logic 0 - All outputs go to high impe-
dance state.

Logic 1 - BCD information is

available at outputs.

updated at selected rate.
/ Data Ready Logic 0 - BCD outputs are valid. Logic

1 - BCD outputs are not valid.

KEYSTROKES FOR SETUP
If the MENU = key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

BCDOUTPUT
1|1 2
413 4
10 |5 6
40 |7 8
100 |9 10
400 111 12
1K 113 14
4K |15 16
10K 17 18
40K 119 20
100K | 21 2
400K 123 24
+POL |25 26
BCDHOLD |27 28
ISOLATED GND |29 30

2
8

20

80

200

800

2K

8K

20K

80K

200K

800K
DATA READY
BCD ENABLE
IS0 5/ 15vDC

M Press Menu Press Digit 531 Press Value Select
md Sclect Key Select Key ¥ ¥ Key
% [ Send unfiltered signal
Press until Output filtering ﬂ Send filtered signal
SEr 1is displayed.
60 Hz 50 Hz
Output update rate Line frequency
0.28 sec 0.34 sec
. 0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
i 4.5sec 54 sec
i 9.1sec 10.9 sec
18.1 sec 21.8 sec
¢ 36.6 sec 43.5 sec
72.5 sec 97 sec
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l 19. EXCITATION OUTPUTS & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated. In
addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (95-240 Vac +10% and 95-300 Vdc +10%) and to
the low voltage power supply (10-34 Vac & 10-48 Vdc).

0000 ooono
bcd e f
a hg
T oo D4ao
Excitation output Jumper locations
b d e
5 Vdc £5%, 100 mA max b,d, e HE B B B EH B
0 b d f
10 Vdc £5%, 120 mA max b, d,f EEEE EBEEBE
24 VVdc £5%, 50 mA max c c
HE BBl BEER BN

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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20. INSTRUMENT SETUP VIA PC

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download /S2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.
2) Meter to be set up.

3) RS232 board in the meter. This board can be 5
used for meter setup, then be removed. s 2 s
4) RJ11-to-DB9 RS232 cable to connect the meter &

and PC (see Section 1, Ordering Guide). PI11-t0.DRA BS.937 cable

5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => |S2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.

[ B [m] 3]
~ComPorts——  Baud Rate- Protocol Select Instrument and Series
@ Cum 1 O 300 ® Custom ASCLL ] — Panel Meter Transmitier
C Com?2 O 600 © Modhus RTU Main Mont
© Com3 O 1200 C Meodhus ASCIT @DPM O Analog Input
C Com 4 O 2400 Help | i
C Com5 O 4300 e O Weight IMeter
arity
O Comé @ 9600 © Countar/Timer © Counter/Timer
O Com 7 19200 & None ——
O Com8
O Com 9 Quit | rSeries
giil
O Series 1
Dlher,[ﬂ Port— S erine?
S Series
[Wait while ing to establish icati —_—
i Continue I Eack Quit
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[ssemn —Ioix| =k
Input+Display|  Scaling Filter ication] Analog Out | Lockouts
Input+Display] _ Scaling | Filer | Rolay Alans | Communication] Anolog Dul | Lockouts - Alarm 1 -Alarm 2
CBASIC Option Sig Cond Option— —Relay I]pt’mn“r(nmm Option Analog Option—— Setpoint 1 “ Sefpeint2 “
(& EXTENDED Boards [” i ﬁne}aynnard __' ‘|§RSZ32 Board j’ﬂrﬁnm L‘ M +010000. M-HJZDDDIJ |
-Deviation 1 Deviation 2
rSigral Input ﬂ +000000. T h-ﬂmuunn 7‘
Mode Range Lustom Curve— —Rate 50,/60 HZ Line Freq‘ T T Al i
[pc v =] ‘ | ozv = ‘VDisahled = (Disahled = ‘Vlsllﬂz A_v_j‘ “Fﬂknd _ﬂ “Fﬂmnd J—‘
~Display Alarm | State Alarm 2 State
Resolution ——— ~Display Filter Decimal Point Peak Button Action 7—Auto Tare “ High Active ] ‘Vl High Active ]
l]q. 5Digits | ‘ ’]Fﬁtered j’ [ddﬂdd _—]’ “Feak = (Dl;ahled = Relayl Alrm State Relay? Alrm State
( | Actve O =] M Actie On 7|
-Deviation 1 Type Dewiation 2 Type
‘V Band Deviat'n 7 | B Band Deviat'n 7|
r Comtrol Inputs Alaym 1 Type Alarm 2 Type
Control Input A --———---. — Controf Input B ---—---—-——— Both Ckrl 4 , B
|VlMeter Reset Meter Hold Cold Reset j‘ ( ) Mon-Latching =] } NoarLaiching =]
= Alaans 1.2 Ne, Rdgs te Alaxm—
hm [~ INo Deviation in Mexu
Main Menu i Main enu

SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

e The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading O’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

2900. L L T —
2875,

Ll B A e LT
2850,
2825, by I R | [ I
2800.

L B e e | | &
2775
2750

L L L L —
2725
2700 1]

2725, 2750, 2775, 2800. 2825 2850, 2875,
Print Save | Pause | Continue | New Scale End
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e The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

e The Jumpers pull-down menu provides prrrErTET 3 o
jumper positions for the various meter boards, “52'““—_”
duplicating information in this manual.

e The Calibration pLI"-dOWI‘l menu allows Scale Factorsetto 10—

easy calibration of voltage and current ranges [ Coie [Desied | Curent o N

Input |Reading |Reading Calib Calib | Reading

for the DC, load cell, and AC RMS signal |ovee | o | -wws Orm | EDs | i
conditioner boards. The PC first recognizes a0z FFES | Feee | oo
the type of board, then prompts you to apply

specific jumpers and calibration signals. Press
Ready to take a reading. Press Repeat to take

more readings. When you have decided on

 [EEEERTEERT

which reading to accept, press on the number [ [
1 through 70 of that reading. Additional cali-
bration software is available online. MENUKEY [S |1 |2 (3[4 |5
ut d C '
METER SETUP WITH AN UNCONNECTED PC ISHET 0 0 0 0 D
Instrument Setup software is also of benefit when the |€onFiG 0 0 0 0 0
PC is not connected to a meter. Upon launching the |FLtEr 0 B 1 1 6
software, click on None for Communications, then on DecPt d d d.d d
DPM and Series 2. Click on File => Default Setup to |SSALE___ /0 /0 0 /1 0
retrieve a default setup file from disk, or on File => Open QRS miojeim 0
Setup to retrieve a previously saved setup file from disk. gg; 0 g f '1]
To enter new setup information, click on View => Setup, |Loe1 0 0 0 0 O
then make your screen selections as if you were | Lgec2z = 0 0 1 0
connected to a meter. Tabs will be grayed out if you | Loc3 0 0 0 D
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under

Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
k=) key, and the seven data columns correspond to values entered via the » and Al keys.

Click on any step in the sequence to bring up a detailed help window.

Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.

Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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21. CUSTOM CURVE LINEARIZATION

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter* so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curve-

fitting algorithm uses quadratic segments of Tank Volume from Pressure
varying length and curvature, and provides at the Bottom of the Tank
diagnostics to estimate curve fitting errors. s

The program is self-prompting, avoiding the
need for a detailed printed manual. This
manual section is only intended as an intro-
duction and get-started guide.

PREREQUISITES 4-20 mA

1) PC-compatible computer with an available Com 1 or Com 2 RS232 port.

2) Extended meter®.

3) An RS232 board in the meter. This board can be
used for meter setup only, then be removed.

.1
4) An RJ11-to-DB9 RS232 cable to connect the VO0OO
meter and PC (see Section 1, Ordering Guide). 2

5) Curve.exe software (downloadable from the web D e
at no charge). R 1-t0-NE9 R5-237 cabla

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the I key to get to K] then
set the entry to ]} Set the meter address to 1. To do so, press the I key to get to =]
7, then set the entry to [NEK]- To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.

You will be given the choice to enter your data in one of four modes:

1) Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from -99999 to
99999 with any decimal point.

2) 2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

3) 2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X*P1 + K2X*P2 +
K3*X*P3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.

You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter 0 and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.

Position of the decimal point from 6=X XXXXX, 5= XX. XXX, 4=XXX. XXX, 3=XXXX.XX,
2=XXXXX. X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the [ decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve

mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad. From
the Menu mode, press the b key to get to  [J§cjen set the fifth digit to either [J
(normal linear operation) or to f (custom curve operation). This fifth digit will only be

displayed with an Extended meter*.

FILES USED OR CREATED BY CURVE.EXE
1) *.RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.

5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.

6) *.PRM contains the final hex data that is downloaded into the meter.
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l 22. METER CALIBRATION I

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibra-
tion, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.

l 23. SPECIFICATIONS '

BASIC METER

Display
TYPC. e 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
{701 o T TR Red or green
RaANge ... -99999 to +99999 and -99990 to +99990
A to D Conversion
Technique (Pat.5,262,780) ......coovouoeeeoeeeeeee e, Concurrent Slope™
Read Rate ......o.oovveeiiieee e 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate........ccccuiiiiiiiiieieee e 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate..........ccooieiiiiiiieii e 3.5/s at 60 Hz, 3/s at 50 Hz

Noise Rejection

CMV from DC t0 60 Hz ..o e e Withstand 250Vac
Dielectric strength .........cviiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMR from DC 0 B0 HzZ ..oooeeeieeeeeeeee e e e e e e e e e e e e e 130 dB
NMR at 50/60 HZ ...ccoooiiiie e 90 dB with minimum digital filtering

Control Inputs (CMOS/TTL levels, logic 1 = tied to digital ground, logic 0 = open)

THOI INPUL Lo Logic 1 holds display and outputs

[ PeaK INPUL. ... Logic 1 displays peak value

[ Tare INPUL oo e e e Logic 1 offsets input value to zero

[ RESEEINPUL ...t Logic 1 resets all meter functions

/ Function Reset input...........coouviiiiiiiiiiiiiieie e Logic 1 resets peak values and alarms

/ Decimal Point input..................... Overrides internal DP selections and controls DP position
ACCURACY
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DC Volts

RTD (0.01°, 0.1°, 1° resolution)

\Q;fgs Resolution (I)r;];:#; E;r5o°rCat I?;;poeo Range Error at 25°C
200.00mV | 10pVv 1GO DIN -202 to 850°C [.01% FS £0.03°C

2.0000 V 100 pVv 1GO 0.01% .00385( -331 to 1562°F | .01% FS +0.05°F

20.000 V 1mV 1 MO of FS

200.00V | 10mV | 1MO | #2Cts ANSI | -20210631°C | 01% FS +0.04°C

3000V | 100mVv | 1 MO .003925( -331 to 1168°F | 01% FS +0.07°F
DC Amps Thermocouple (0.1°, 1° resolution)

%;:Zr: Resolution (I)nhpnlii E;rSOOrg t T-;ge Range Error at 25°C
2.0000mA | 0.1 pA 100 O 0.01% J -210 to 760°C [.01% FS £0.09°C
20.000 mA 1 uA 100 ' -347to 1400°F | .01% FS +0.16°F
20000mA | 10pA | 10 | OFS

5 000 A 1 mA 0.010 +2 Cts K -244 10 1372°C |.01% FS +£0.10°C

-408to 2501°F | .01% FS +0.17°F
Ratio 0to 400°C |[.01% FS £0.03°C
. -257t0 0°C [.01% FS £0.20°C

Current Resolution Input Error at 3210 752°F |.01% FS £0.05°F

Range Ohms 25°C -430 to 32°F |.01% FS +0.36°F
200.00 mV (10 pVv 1GO 0.01% c -240 to 1000°C |.01% FS +0.18°C
2.0000V (100 pV 1GO of FS -400 to 1830°F | .01% FS +0.32°F
20000V |1 mV 1Mo +2 Cts N -245 t0 1300°C |.01% FS +£0.10°C

-410 to 2370°F | .01% FS +0.17°F
True RMS Volts (1% to 100% of Full Scale)
s -46 to +68°C |.01% FS +£0.12°C

\éoltage Resolution | nPut | Errorat -51to +213°F | .01% FS +0.22°F

ange Ohms 25°C
R -45 10 1768°C [.01% FS +0.17°C
200.00mV | 10pV | 22MO | g g0 -49 to 3214°F | .01% FS +0.31°F
2.0000V | 100 Vv 22 MO of.FS
20.000 V 1mv 1MO 10 Hz ’,[0 Load Cell Input
200.00 V 10 mV 1 MO 10 kHz
2500V 100 mv 1 MO Input Reso- |Output| Output |Error at
Zero Span
True RMS Amps (1% to 100% of Full Scale) Range lution |Range| Range | 25°C
Current Resolution Input Error at 20.000 mV | 1 pVv .
Range Ohms 25°C 50.000 mV (2.5 pV [-99999 0to 0.01%
100.00 mV | 5V to of FS
2.0000mA| 0.1 pA 1000 0.15% 250.00 mV |12.5 yV| 99999(+99,999 | +1 Ct
20.000 mA 1 pA 100 of FS, 500.00 mV | 25 pV
200.00 mA| 10 pA 10 10 Hz to
5.000A | 0.25mA | 0.010 10 kHz
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SPAN TEIMPCO ...ttt e e e e e rar e e e e e e aeens 0.003% of reading/°C
0.0015% of reading/°C for load cell meter Zero Tempco

............................................................................................................ 0.2 yv/°C
Reference JUNCLION ACCUIACY .........couviiiiiiiiiiiiiiiiie e 1°C, 10°C to 40°C
POWER REQUIREMENTS
Input Voltage rating (standard) ...........cccoiieeiinnnnnn. 95-240V ac +10% or 90-300V dc +10%
Input Voltage rating (low voltage option)..........cccoiiiiiiiiiiiiiiiee 10-34V ac or 1048V dc
Power Line FreqUeNCY.........cooo i DC and 47-63 Hz
Power ConsumMPLioN, IMBX...........eueiiii et et e e e eeee s 5 Watts

EXCITATION OUTPUTS

Voltage & Current Levels (jumper selectable) .........cccccceveiiiiiiinnnn. 5V dc £5%, 100 mA max
10V dc +5%, 120 mA max
24V dc £ 5%, 40 mA max

Excitation Output RIPPIE ...ooiiiiie e 100 mVp max
Isolation from power and OUIPULS..........uiiiiiiiiiic e 250 Vac
Insulation dielectric strength to power and outputs ..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation t0 SIgNal COMIMON ... ... 50V dc

DUAL RELAY OPTION

Power to Relay Option.........cooooi Powered by meter
Setpoint Setup .....ooeviiiiiii e Via front panel pushbuttons or RS232/485
Update Rate ......cooeeieeee e 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (Min) ... Display update rate
Input Signal (selectable) ..., Filtered or unfiltered input signal

Actuation Modes (selectable) ...... Above or below setpoint, latching or non-latching,
disabled Output Time Delay (selectable) ... 1t0128
readings Front Panel Enable / Lockout Modes (selectable) ............... 1) Display and change

setpoints 2) Display but do not change setpoints 3) Neither display nor change setpoints

Alarm Status INdiCation.............cooii i 2 red LED lamps
Status Indication Setup (selectable) ...................... Lit when output is ON or OFF, or disabled
Contact Relay Output:

AC RAEING .ottt ettt e te e et nee e e e s nnnna 8A @ 240V ac
D L@ = 1o SOOI 8A @ 24V dc
Isolation rating between signal common and contacts...............coeeiiiiiiiiiiiiiiiiiiiiiienens 250V ac
Insulation dielectric strength between signal common and contacts.............cccccooiiiiiiiiiiiieinnnn.
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Solid State Relay Output:

AC Rating ....ooovviiiiiiiiiiii 120 mA @ 125V ac, 24 ohms series resistance
DC RatiNg ..eeeeieiiiieie 240 mA @ 150V dc, 6 ohms series resistance
Isolation rating between signal common and contacts................ceceviiiiiiiiiiiiiiiiiiiienens 250V ac
Insulation dielectric strength between signal common and contacts.............ccccoooiiiieiiiiirinnnnn.
.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
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ANALOG OUTPUT OPTION

Power to Analog Output OPtioN .........cooiiiiiiiiii e Powered by meter
Output Levels (voltage & current available simultaneously) ...0-20 mA or 4-20 mA and 0-10V
Voltage Compliance, 0-20 MA Output ......ccceeiviiiiiiiiiee e 12V (0-600 Ohm load)
Current Compliance, 0-10V Output.........cccceeeiieeiiiiiiieeeee 2 mA (5 kOhm or higher load)
ACCUACY......umeeiiiiiiiiieiiee e Meter input accuracy +0.1% of full scale analog output
RESPONSE  TIME..oiiiiiiieiie e Display update rate
Scaling of Reading for Zero Output ..........ccociiiiii i -99,999 to +99,999
Scaling of Reading for Full Scale Output .........cccoiiiiiiii e -99,999 to +99,999
Isolation rating between signal common and analog output ... 250V ac
Insulation dielectric strength between signal common and analog output ..o

.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

SERIAL INTERFACE OPTION (RS232, RS485, RS485-Modbus boards)

Power to Interface Option ... Powered by meter
RS485 WIFING it e e e e e Half or full duplex
Baud Rates........ccoiiiiiiiei e 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols..........cccceeenneee. Custom ASCII*, Modbus* RTU, Modbus* ASCII (selectable)
Signal Levels ... Meet RS232 and RS485 standards
Connectors ................ Single RJ11 (RS232), two RJ11 (RS485), two RJ45 (RS485-Modbus)
Isolation rating between signal common and serial 1/O.........cocovviiiiiiii, 250V ac
Insulation dielectric strength between signal common and serial l/O..............ccccooiiiiiiiiiineeen.

.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

Power to BCD Output Option.........ooooiiiiiiiiiiee e Powered by meter
I3 L= TP PPPRPPRPPPPI 3-state, stored, parallel
SIgNal LEVEIS ... e LSTTL, CMOS compatible
(070701 (o] =TT BCD Enable, Hold, Data Ready
Isolation rating between signal common and BCD output ...........cccooooiiiiiiiiiiiiiiiiiinns 250V ac
Insulation dielectric strength between signal common and BCD output ............ccccoeeveeeeinnnn.

.................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

ENVIRONMENTAL

Operating Temperature ...........oooi oot eee e e e e e e e e e e e e eaeaeeees 0°C to 55°C
Storage TemPerature..........ueiii i -40°C to 85°C
Relative HUMIdity.........ccooiiiiiieeeee e 95% from 0°C to 40°C, non-condensing
CASE e NEMA-4X from front when panel mounted
SOCK. .. e 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ..o, 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 24. GLOSSARY OF TERMS |

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched
An alarm which stays actuated until reset. Setpoint .~ ON ™

X 1000 poin
Latched alarms can shut down machinery or :
a process when an operating limit has been \
exceeded, or maintain an alarm condition
until acknowledged by an operator.

OFF ON ™.

er Reading

Alarm, Non-latched
An alarm which changes state automatically
when the reading rises above a specified limit
and changes back automatically when the
reading falls below a limit.

Setpoint o~ ON ™,
1000 ; )

Autofilter A selectable digital filter mode which auto- OFF OFF

matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Meter Reading

NON-LATCHED ALARM

Time

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus

protocol, which is also offered with the meters.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).

-52--



Setting up a passband around a setpoint is
often used for component testing. Deviation .
limits are programmed by entering menu item |, ;| Fal LA
dEU1b for Alarm 1 and dEU2b for Alarm 2. |, .| Pass s o g W, B
The deviation band will be equal to two limits. | g5o| Pass,’s,” ® SEPont &% %

50
Fail ¥ .
. . . . =) *
Display Blank A rear papel input .WhICh blapks the display | £'| ¢, Sefpoint = 1000
when the input is tied to logic ground by a | § Deviation limit = 50
switch or OV is applied (logic level true). The | © Deviation band = 100
meter display will light when the input is open Parts

or is held at +5V (logic level false).

Extended Meter
A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of

change from successive readings.

Full Scale The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset
A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic level
false) and then set low.

Ground Loop A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.

Jumper A push-on component which provides a short between two adjacent posts on a circuit
board. Jumpers are used to configure signal conditioner boards for specific
signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.

Hysteresis Band
A bgnd which controls relgy action sym- TR R T S —
metrically around a setpoint. The relay . OFF . OFF . OFF
closes (or opens) when the reading goes \ i i
above the setpoint plus one hysteresis limit, |1000 |Hgéter \ Hegter) Hegter \

. ON ON QN :
and opens (or closes) when the reading 9 \ b \\
falls below the setpoint less one hysteresis . i
limit. A narrow hysteresis band is often
used to minimize relay chatter around a
setpoint due to electrical noise or signal
feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump

1050
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Setpoint = 1000
Hysteresis limit = 50
Hysteresis band = 100

Reading

Time
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when the tank level has reached an upper limit. The hysteresis band will be
equal to two hysteresis limits.

Menu Mode The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

Meter Hold A rear panel input which freezes the meter display and all meter outputs while that
input is tied to logic ground by a switch or is held at OV (logic level true). The
meter will resume operation when the input is allowed to float or is held at +5V
(logic level false).

Modbus An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving Average Filter
A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

Offset A constant adder used for the displayed reading. This is the term b in the straight line
formula y = mx + b, where y is the displayed reading in counts, m is the scale
factor, x is the measured reading in counts, and b is the offset. For direct
readout in (milli)volts or (milli)amps, offset is 0.

Peak Display The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Process Signal
A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.

Rate of Change Meter
A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
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Reading The value displayed by the meter. “Taking a reading” is the action of the meter to
make an analog-to-digital conversion. Readings are taken at 60/sec with 60 Hz
power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.

Remote Display
A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.

Reset There are three types of Reset:

» Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.

= Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.

= Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII
command. rESEt is displayed briefly.

RS485 Half Duplex
Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 Full Duplex
Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

Run Mode The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

Scale A constant multiplier used to go from A/D 8
converter counts to displayed counts. Thisis | >g
the slope term m in the straight line formula y |£ 2
= mx + b, where y is the displayed reading in g 8 . High input,
counts, m is the scale factor, x is the gg" e high reading
measured reading in counts, and b is the % = o Low input,
offset. For direct readout in (millivolts or |8 & low reading
(milli)amps, scale is 1. o[ Offsetb

Scaling The process of setting scale and offset so ° 5 Counts x from A/D corverter
that the meter reads properly in engineering Fullioiali-57 768 10°32. 768

units (such as psi).

Scaling, Coordinates of 2 Points Method
A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
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then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item.

Scaling, Scale and Offset Mmethod

A scaling method where scale and offset are entered manually.

Scaling, Reading Coordinates of 2 Points Method

Setpoint

Span

Tare

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the
setpoint.

The number of counts corresponding to a given signal range.

A rear panel input which causes the display to be set to zero when the input is
momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

Valley Display

The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Zero When used with process meters, zero is an adjustment so that a given low transducer

output reads zero on the meter. Zero is adjusted by programming offset.
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| 25. WARRANTY |

London Electronics Ltd. warrants its products against defects in materials or workmanship for a
period of one year from the date of purchase.

In the event of a defect during the warranty period, the unit should be returned, freight prepaid
(and all duties and taxes) by the Buyer, to the authorized London distributor where the unit was
purchased. The distributor, at its option, will repair or replace the defective unit. The unit will be
returned to the buyer with freight charges prepaid by the distributor.

LIMITATION OF WARRANTY
The foregoing warranty shall not apply to defects resulting from:

1. Improper or inadequate maintenance by Buyer.

2. Unauthorized modification or misuse.

3. Operation outside the environmental specifications of the product.
4. Mishandling or abuse.

The warranty set forth above is exclusive and no other warranty, whether written or oral, is
expressed or implied. London specifically disclaims the implied warranties of merchantability
and fitness for a particular purpose.

EXCLUSIVE REMEDIES

The remedies provided herein are Buyer's sole and exclusive remedies. In no event shall
London be liable for direct, indirect, incidental or consequential damages (including loss of
profits) whether based on contract, tort, or any other legal theory.
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